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1. ВСТУП 

Навчальна дисципліна «Гідроінформатика» розроблена для 

студентів, які навчаються за освітньо-професійними програмами 

«Прикладна інформатика» (спеціальність 122 «Комп’ютерні 

науки») та «Прикладна математика» (спеціальність 113 

«Прикладна математика») і складена згідно відповідним 

освітньо-професійним програмам. 

1.1. Анотація 

Гідроінформатика - це вивчення інформаційних потоків та 

генерування знань, що стосуються руху води в реальному світі 

через інтеграцію інформаційно-комунікаційних технологій для 

збору даних, моделювання та підтримки прийняття рішень, 

наслідків для водного середовища та суспільства, управління 

водними системами. Тому фахівцю, зокрема магістру, що 

навчається на освітній програмі «Прикладна інформатика» 

спеціальності «Комп’ютерні науки» в НУВГП, для якого «водний 

напрям» є ключовим, необхідні знання про основні види та 

особливості застосування сучасних інформаційних технологій у 

водній галузі. 

Місце дисципліни в структурно-логічній схемі підготовки 

для студентів «Прикладна інформатика»: 

Дисципліни, що передують вивченню даної дисципліни: 

• Теорія комп’ютерних систем та методологія їх 

проектування 

• Іноземна мова професійного спілкування 

Дисципліни, які вивчаються одночасно з даною дисципліною 

• Методологія наукових досліджень 

• Дослідження еко-інформаційних систем методами  

математичного та комп’ютерного моделювання 

Освітні компоненти, які спираються на дану дисципліну 

• Кваліфікаційна робота 

1.2. Ключові слова 

 Гідроінформатика, водні ресурси, водна інженерія, 

гідрологія, моделювання гідравлічних процесів. 

Keywords: Hydroinformatics, water resources, water 

engineering, Hydraulic engineering, Hydrology,  Hydrological model 

https://start.nuwm.edu.ua/bakalavr/item/kompiuterni-nauky-prukladna-informaticai-m
https://start.nuwm.edu.ua/bakalavr/item/prykladna-matematyka-m
https://uk.wikipedia.org/wiki/%D0%93%D1%96%D0%B4%D1%80%D0%BE%D1%96%D0%BD%D1%84%D0%BE%D1%80%D0%BC%D0%B0%D1%82%D0%B8%D0%BA%D0%B0
https://uk.wikipedia.org/wiki/%D0%92%D0%BE%D0%B4%D0%BD%D1%96_%D1%80%D0%B5%D1%81%D1%83%D1%80%D1%81%D0%B8
https://en.wikipedia.org/wiki/Hydrology
https://en.wikipedia.org/wiki/Hydroinformatics
https://en.wikipedia.org/wiki/Water_resources
https://en.wikipedia.org/wiki/Hydraulic_engineering
https://en.wikipedia.org/wiki/Hydrology
https://en.wikipedia.org/wiki/Hydrological_model


2. МЕТА ТА ЗАВДАННЯ НАВЧАЛЬНОЇ ДИСЦИПЛІНИ 

 

2.1. Мета  

Основною метою дисципліни «Гідроінформатика» є 

формування у майбутніх фахівців знань про методи та засоби 

прийняття інженерних рішень у водогосподарській галузі з 

використанням гідроінформаційних технологій, на засадах 

математичного моделювання; формування системного, 

аналітичного мислення для оцінки ситуацій, пов’язаних з дією 

води, а також розвиток вміння визначати потреби споживачів 

програмних продуктів з урахуванням їх призначення, 

особливостей умов використання та вимог до точності і 

стабільності результатів. 

 

2.2. Завдання 

Основними завданнями, що мають бути вирішені при 

вивченні  дисципліни, є: 

 сформувати уявлення про основні компоненти навчальної 

дисципліни «Гідроінформатика»; 

 сформувати структуровані знання про сучасні гідро 

інформаційні програмні продукти, їх можливості, принципи та 

особливості роботи; 

 розкриття можливостей сучасного програмного 

забезпечення та ефективного застосування інформаційних 

технологій в інженерній діяльності у водогосподарській галузі. 

 сформувати навички формувати програмні продукти для 

виконання заданих функції з урахуванням особливих, зокрема у 

водній інженерії, вимог, створення зручного та 

клієнтоорієнтованого UI-дизайну (User Interface Design) 

програмного продукту. 

2.3. Компетентності 

Навчальна дисципліна надає можливість студентам 

оволодіти наступними компетентностями: 

Загальні компетентності:  

Загальні компетентності ОП «Прикладна інформатика»  
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ЗК1. Здатність до абстрактного мислення, аналізу та синтезу.  

ЗК2. Здатність застосовувати знання у практичних ситуаціях.  

ЗК3. Здатність спілкуватися державною мовою як усно, так і 

письмово. 

ЗК5. Здатність вчитися й оволодівати сучасними знаннями.  

ЗК6. Здатність бути критичним і самокритичним.  

ЗК7. Здатність генерувати нові ідеї (креативність).  

ЗК9. Здатність оцінювати та забезпечувати якість виконуваних 

робіт.  

Спеціальні компетентності ОП «Прикладна інформатика»: 

ФК4. Здатність формалізувати предметну область певного 

проєкту у вигляді відповідної інформаційної моделі.  

ФК6. Здатність збирати і аналізувати дані (включно з великими), 

для забезпечення якості прийняття рішень.  

ФК7. Здатність розробляти, описувати, аналізувати та 

оптимізувати архітектурні рішення інформаційних та 

комп’ютерних систем різного призначення.  

ФК15. Здатність до оригінального мислення та проведення 

досліджень, критичне осмислення проблем у сфері 

комп’ютерних наук та на межі галузей знань.  

ФК16. Здатність опанувати сучасні технології математичного 

моделювання об’єктів, процесів і явищ, розробляти 

обчислювальні моделі та алгоритми чисельного розв’язання 

задач математичного моделювання.  

ФК17. Здатність використовувати професійно-профільні знання 

та практичні навички з математики, математичного 

моделювання, програмування, комп’ютерного моделювання при 

проектуванні програмних систем для процесів різної природи..  

2.4. Програмні результати навчання 

для студентів «Прикладна інформатика» 

ПРН1. Здійснювати опис предметної області розробки або 

дослідження; забезпечувати декомпозицію поставленої задачі.  

ПРН2. Обирати належні засоби для розробки або дослідження 

(середовище розробки, мова програмування, програмне 

забезпечення та програмні пакети тощо), що дозволяють знайти 

правильне і ефективне рішення.  
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ПРН3. Аналізувати проміжні результати розробки або 

дослідження з метою з'ясування їх відповідності вимогам; 

розробляти тести та використовувати засоби верифікації, щоб 

переконатися у якості прийнятих рішень. 

ПРН7. Створювати прототипи програмного забезпечення, щоб 

переконатися, що воно відповідає вимогам до розробки; 

виконувати його тестування і статичний аналіз, щоб 

переконатися у відповідності завданню розробки або 

дослідження. 

ПРН9. Управляти складними робочими процесами з урахуванням 

поставлених економічних, правових та етичних аспектів, 

оцінювати результати діяльності команди. 

ПРН10. Вільно спілкуватися державною та англійською мовами 

усно і письмово для обговорення професійної діяльності у сфері 

інформаційних технологій, проєктів, результатів досліджень та 

інновацій, інших питань комп’ютерних наук.  

ПРН11. Відшуковувати необхідну інформацію у науковій 

літературі, базах даних, інших джерелах, аналізувати і оцінювати 

її. 

ПРН13. Мати спеціалізовані концептуальні знання, що 

включають сучасні наукові здобутки у сфері інформаційних 

технологій і є основою для оригінального мислення та 

проведення досліджень. 

2.5. Знати та вміти 

Після вивчення даної навчальної дисципліни студенти 

повинні  

знати:  

• сфери застосування та особливості роботи 

гідроінформаціного програмного забезпечення для управління 

водними ресурсами, гідрологічних, гідравлічних та інших 

інженерних розрахунків у водній інженерії;  

• основні напрямки розвитку гідроінформаційних систем; 

• основні терміни гідроінформаційних технологій; 
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• знати структуру гідроінформаційних баз даних, в тому 

числі з відкритим доступом. 

вміти:  

 використовувати базове програмне забезпечення за 

напрямком гідроінформатики; 

 використовувати гідроінформаційні бази даних, в тому числі 

з відкритим доступом; 

 при формуванні програмних продуктів, зокрема у водній 

інженерії,  створювати зручний та клієнтоорієнтований UI-

дизайн (User Interface Design). 

 

3. ПРОГРАМА НАВЧАЛЬНОЇ ДИСЦИПЛІНИ 

Змістовий модуль 1. Основи гідроінформатики  

Тема 1. Місце інформаційних технологій у водному 

господарстві  

Історія виникнення, розвиток та актуальні задачі 

гідроінформаційних технологій. Освітні програми 

гідроінформаційного напрямку у світі. Види та класифікація 

програмних продуктів у напрямку гідроінформатики. (Література 

[1]–[7]). (10 / 2 / 0 / 0 / 8) 

Тема 2. Джерела гідроінформаційних даних  

Огляд основних інформаційних сайтів з гідро 

інформаційними даними. Інформаційна база інженерного 

гідрологічного центра США (U.S. Army Corps of Engineers' 

Hydrologic Engineering Center – далі HEC) HEC-DSS (Data Storage 

System) та програма редагування HEC-DSSVue. Формати даних, 

умови отримання інформації. (Література [8], [9]). (12 / 2 / 2 / 0 / 

8) 

Тема 3. Застосування дистанційного зондування землі 

(ДЗЗ) у водній інженерії  

Основи застосування ДЗЗ для захисту від повеней та 

поводків. Причини та наслідки повеней  та паводків. Існуючі 

інформаційні технології моніторингу повеней з використанням 

даних дистанційного зондування землі (ДЗЗ). Технологія 
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обробки даних супутникових знімків. Водний індекс (WRI). 

Нормалізований різницевий водний індекс (NDWI) та (NDWI2). 

Модифікований нормалізований різницевий водний індекс 

(MNDWI). Нормалізований різницевий індекс водойм (NDPI). 

Етапи комплексного оперативного супутникового моніторингу 

весняних повеней. Розробка інформаційних продуктів. 

(Література [10]–[15]). (14 / 4 / 2 / 0 / 8) 

Змістовий модуль 2. Особливості застосування 

гідроінформаційних продуктів 

Тема 4. River Analysis System HEC-RAS – пакет програм 

для гідравлічних розрахунків природних та штучних 

водотоків   

Призначення, місце в структурі програмних продуктів 

Hydrologic Engineering Center (CEIWR-HEC). Теоретичні основи 

розрахункових процедур. Особливості встановлення, структура 

меню, проведення гідравлічних розрахунків. (Література [16]–

[22]) (28 / 4 / 8 / 6 / 10)   

Тема 5. Hydrologic Modeling System (HEC-HMS) пакет 

програм для моделювання гідравлічних процесів систем 

водозбору  

Призначення, місце в структурі програмних продуктів 

CEIWR-HEC. Теоретичні основи розрахункових процедур. 

Особливості встановлення, структура меню, проведення 

моделювання. (Література [23]–[26]). (14 / 2 / 2 / 0 / 10) 

Тема 6. Система управління водними ресурсами (CWMS) 

та HEC-RTS (Real Time Simulation)  

Призначення, теоретичні основи розрахункових процедур 

CWMS та HEC-RTS. Особливості встановлення, структура меню, 

проведення моделювання. (Література [27], [28]) (14 / 2 / 4 / 0 / 

10) 

Тема 7. Геоінформаційні системи у водній інженерії  

Призначення, теоретичні основи ГІС. Формування 

геоінформаційної основи у водній інженерії. Особливості, 

структура, отримання моделей рельєфу у QGIS (Вільна 

географічна інформаційна система з відкритим кодом). HEC-
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GeoHMS як складова HEC-HMS. (Література [29]–[32]) (14 / 2 / 2 

/ 0 / 10) 

Тема 8. Системи оповіщення про повені  

Глобальна система оповіщення про повені (GloFAS) – 

прогнози, гідрологічна модель. GloFAS map viewer - web-mapping 

platform.  (Література [33], [34]) (14 / 2 / 2 / 0 / 10) 

 

4. ТЕМИ ЛАБОРАТОРНИХ ЗАНЯТЬ 

1. Ознайомлення з основними  джерелами 

гідроінформаційних даних в Україні та світі (2 год.) 

2. Застосування дистанційного зондування землі (ДЗЗ) у 

водній інженерії (2 год.) 

3. Ознайомлення та виконання проекту в HEC-RAS (8 год. + 

ІНДЗ 6 год.) 

4. Ознайомлення з роботою HEC-HMS та HEC-GeoHMS (2 

год.) 

5. Ознайомлення з роботою  CWMS) та HEC-RTS (2 год.) 

6. Особливості роботи QGIS --- провідної вільної настільної 

ГІС (2 год.) 

7. Особливості глобальної системи оповіщення про повені 

GloFAS (2 год.) + Case Study: 

a. Прогнозування часу та тривалості мусонних 

паводків (Бангладеш) 

b. Прогнозування повеней (Бразилія) 

c. Робота системи раннього попередження р. Іраваді 

(Мьянма) 

d. Прогноз повені в Пакістані 2010 р. 

 

5. РОЗПОДІЛ САМОСТІЙНОЇ ТА ІНДИВІДУАЛЬНОЇ 

РОБОТИ 

 20 годин – вивчення літератури по курсу і розробка 

лекційних конспектів  (20+20)х(0,5 год. / 1 год. аудиторних 

занять); 
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 24 годин – підготовка до контрольних заходів (6 год. на 

4,0 кредити ECTS); 

 30 годин – опрацювання окремих розділів програми, які 

не розглядаються під час аудиторних занять (див.п.5.1. Завдання 

для самостійної  роботи.  

 6 годин - виконання індивідуальних навчально-

дослідних завдань. 

5.1. Завдання для самостійної  роботи 

1. COMSOL Multiphysics – розрахункова гідродинаміка 

(https://www.comsol.com/multiphysics); 

2. COMSOL Multiphysics – фільтрація в пористому середовищі 

(https://www.comsol.ru/porous-media-flow-module); 

3.  COMSOL Multiphysics – фільтрація в ґрунтах 

(https://www.comsol.ru/subsurface-flow-module); 

4. COMSOL Multiphysics – рух води в трубах 

(https://www.comsol.ru/pipe-flow-module); 

5. Корпоративна система управління водними ресурсами 

(CWMS) (https://www.hec.usace.army.mil/cwms/); 

6. Hydrologic Engineering Center Data Storage System, or HEC-DSS 

– система зберігання даних HEC 

(https://www.hec.usace.army.mil/software/hec-dss/); 

7. River Analysis System (HEC-RAS) – особливості гідрологічних 

розрахунків (https://www.hec.usace.army.mil/software/hec-ras/ 

); 

8. Hydrologic Modeling System (HEC-HMS - 

https://www.hec.usace.army.mil/software/hec-hms/ )  

9. OpenGeoSys (OGS) – моделювання термо-гідро-механіко-

хімічних (THMC) процесів в пористих і тріщинуватих 

середовищах (https://www.opengeosys.org/ ). 

10.  Активно - пасивне дистанційне зондування для моніторингу 

небезпечних процесів на територіях 

 

https://www.comsol.com/multiphysics
https://www.comsol.ru/porous-media-flow-module
https://www.comsol.ru/subsurface-flow-module
https://www.comsol.ru/pipe-flow-module
https://www.hec.usace.army.mil/cwms/
https://www.hec.usace.army.mil/software/hec-dss/
https://www.hec.usace.army.mil/software/hec-ras/
https://www.hec.usace.army.mil/software/hec-hms/
https://www.opengeosys.org/
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6. ІНДИВІДУАЛЬНЕ НАВЧАЛЬНО-ДОСЛІДНЕ 

ЗАВДАННЯ 

Індивідуальне навчально - дослідне завдання (ІНДЗ) може 

виконуватись кожним студентом за індивідуально отриманим 

завданням або самостійно обраною темою. Зміст ІНДЗ 

передбачає застосування отриманих теоретичних знань та 

навичок щодо конструкції, класифікації, принципів роботи та 

застосування основних видів сенсорів і виконавчих елементів. 

Обсяг ІНДЗ складає до 24 стор. Порядок виконання та 

оформлення ІНДЗ відповідно діючим вимогам до ІНДЗ студентів. 

Бажане представлення результатів ІНДЗ у вигляді публічного 

виступу. 

Тематика ІНДЗ обирається індивідуально і може 

відповідати темам, винесеним на самостійне опрацювання. 

7. МЕТОДИ КОНТРОЛЮ 

Для визначення рівня засвоєння студентами навчального 

матеріалу використовуються наступні методи оцінювання знань: 

- поточне тестування після вивчення кожного змістового 

модуля (МК1-10, МК2-30 балів); 

- оцінка за індивідуальні навчально-дослідного завдання – 

5 балів; 

Дисципліна закінчується екзаменом, тому результати 

складання модульних контролів можуть зараховуватись  як 

підсумковий контроль. 

Контроль роботи студентів проводиться за такими видами 

робіт: 

- робота на лабораторних заняттях – шляхом усного 

опитування і перевірки виконаних звітів і наявності висновків по 

5 балів за роботу; 

- підготовка рефератів, доповідей, наукових статей, тез для 

участі в конференціях – до 10 балів; 

- участь в конкурсах, олімпіадах – до 20 балів. 



8. ЛАБОРАТОРНІ РОБОТИ 

8.1. Встановлення, налаштування та основи роботи в 

програмі HEC-RAS 

1. Вступ 

Мета роботи - ознайомитись з особливостями та 

основними налаштуваннями програмного комплексу HEC-RAS; 

навчитись формувати вихідну інформацію з використанням 

геопросторових баз даних, складати прості моделі, задавати 

крайові умови роботи моделі.  

Оснащення робочого місця: методичні вказівки з 

виконання роботи, таблиці з індивідуальними вихідними даними, 

програмного комплексу HEC-RAS. 

2. Порядок виконання роботи 

1. Головне меню Hec-Ras (Step 1. Open up Hec-Ras) 

 

 

 
Рис. 2. 1.  Open up Hec-Ras: 1. Управління файлами; 2. 

Введення та редагування даних, (Edit), 3. Гідравлічні аналізи, 4. 

Табличне та графічне відображення вхідних та вихідних даних, 

5. Картографування затоплення та анімація розповсюдження 

води, 6. Звітні засоби, 7. Контекстно чутлива довідка 

 

Структура основного меню 

 

1. Робота з файлами (File)  

 New Project…  (створення нового проекту, з розширенням 

.PRJ) один файл для кожного плану (Plan) (від .P01 до .P99) 

 Open Project … 

 Save Project … 

1 2 3 5 7 

4 6 
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 Save Project As (Оновлює файл проекту та всі інші пов’язані 

дані, зберігаючи всю інформацію до нового імені файлу, яке ви 

вказали.) 

 Rename Project Title … (перейменування ) 

 Delete Project … 

 Project Summary … (підсумки за проектом: розташування 

каталогів; плани проектів; перелік файлів, що містяться в проекті; 

і наразі відкрита статистика плану (тобто кількість різних 

елементів). 

 Import HEC-2 Data … Імпорт даних з 

 Import HEC-RAS Data … 

 Generate Report … Створити звіт 

 Export GIS Data … Експортувати у GIS 

 Export to HEC-DSS … експортувати в HEC-DSS 

 Restore Backup Data Відновлення резервних даних 

 Debug Report (compress current plan files)… 

 Exit 

 Last Projects 

 

2. Редагування (Edit) 

 Geometric Data (геометричні дані, Geometry files have the 

extension .G01 to .G99.). "G" позначає файл геометрії, тоді як 

число відповідає порядку, в якому вони були збережені для цього 

конкретного проекту. Файли геометрії містять усі геометричні 

дані для річкової системи, що аналізується. Геометричні дані 

складаються з: інформації про переріз; дані гідротехнічних 

споруд (наприклад, мости та водопропускні споруди); 

коефіцієнти; моделювання інформації про підхід. Дані геометрії 

збе-рігаються у форматі ASCII. Файл містить ключові слова для 

опису кожної частини даних, і він є найбільш зрозумілим. Файл 

геометрії створюється користувальницьким інтерфейсом 

кожного разу, коли проектант вибирає New Geometry Data або 

Save Geometry Data As у вікні Геометричні дані (Geometric Data). 

Кожен файл геометрії має відповідний файл HDF5, який 

використовується для підтримки Mapper HEC-RAS, [20, с. 4–4]. 
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 Steady Flow Data (Дані стаціонарного потоку, extension .F01 to 

.F99). "F" означає, що це файл даних усталеного потоку Steady 

Flow Data Files, тоді як число відповідає порядку, в якому вони 

були збережені для цього конкретного проекту. Файли даних 

містять: кількість профілів, що підраховуються; дані про потоки; 

та граничні умови для кожної ділянки ріки. Файли зберігаються 

у форматі ASCII. Файл містить ключові слова для опису кожної 

частини даних. Файли даних автоматично створюються 

користувальницьким інтерфейсом, коли проектант вибирає New 

Flow Data або Save Flow Data As у вікні Steady Flow Data, [20, с. 

4–4]. 

 Quasi Unsteady Flow (Sediment Analysis) (Квазі 

нестаціонарний потік (аналіз наносів, extension .Q01 to .Q99). "Q" 

означає, що це файл нестаціонарного потоку даних, тоді як число 

відповідає порядку, в якому вони були збережені для цього конк-

ретного проекту. Файли даних квазінестабільного потоку 

містять: гідрографи потоку на вищих межах; умови запуску 

потоку; та нижчі граничні умови. Файли даних з квазінестійким 

потоком зберігаються у форматі ASCII. Файл містить ключові 

слова для опису кожної частини даних, і він є найбільш 

зрозумілим. Файли даних квазінестабільного потоку 

автоматично створюються користувальницьким 

інтерфейсом,коли проектант вибирає New Flow Data або Save 

Flow Data As у вікні Quasi-Unsteady Flow Data, [20, с. 4–5]. 

 Unsteady Flow Data (Дані нестаціонарного потоку, extension 

.U01 to .U99). "U" означає, що це файл даних нестаціонарних 

потоків, тоді як число відповідає порядку, в якому вони були 

збережені для цього конк-ретного проекту. Файли даних про 

нестабільний потік містять: гідрографи потоку на вищих межах; 

умови запуску потоку; та нижчі граничні умови. Файли даних 

нестаціонарного потоку зберігаються у форматі ASCII. Файл 

містить ключові слова для опису кожної частини даних. Файли 

даних автоматично створюються користувальницьким 

інтерфейсом, коли проектант вибирає New Flow Data або Save 

Flow Data As у вікні Unsteady Flow Data, [20, с. 4–4]. 
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 Sediment Data (Дані про наноси, extension .S01 to .S99 ), [20, с. 

4–5] 

 Water Quality Data (Дані про якість води, extension .w01 to 

.w99) 

3. Пуск (Run) 

 Steady Flow Analysis (Аналіз стаціонарного потоку, Run file 

for each steady flow plan мають розширення від .R01 до .R99) 

 Unsteady Flow Analysis (Аналіз нестаціонарного потоку, Run 

file for each unsteady flow plan мають розширення від .X01 до 

.X99) 

 Sediment Analysis (Аналіз наносів) 

 Water Quality Analysis (Аналіз якості води) 

 Hydraulic Design Functions (Функції гідравлічного дизайну, 

Hydraulic design data files have the extension .H01 to .H99.), [20, с. 

4–5] 

Run Multiple Plans (Пуск кількох планів) 

4. Перегляд (View) 

• Cross-Sections  (Поперечні перерізи) 

• Water Surface Profiles (Профілі поверхні води) 

• General Profile Plot (Загальний розріз) 

• Rating Curves (Крива витрат) 

• X-Y-Z Perspective Plots (Проекція розрізів) 

• Stage and Flow Hydrographs (ступінчастий та гідрограф потоку) 

• Hydraulic Property Tables (Таблиці гідравлічних властивостей) 

• Detailed Output Tables (Детальні дані по кожному поперечному 

перерізу) 

• Profile Summary Table (Сумарна таблиця профілю) 

• Summary Err, Warn, Notes (Підсумкові помилки, попередження, 

примітки) 

• DSS Data (Дані Data Storage system) 

• Sediment Output (Результуючі дані по осадам) 
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Рис. 2. 2. Схема файлів даних проекту, [20, с. 4–6] 

 

 

2. Визначення назви проекту і створення системи папок 

 

Перейдіть у меню File та виберіть Новий проект (New 

Project, Рис. 2.3), потім виберіть диск та папку та введіть назву 

проекту (project Title), Рис. 2.4. 
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Рис. 2.3. New Project 

 

Визначивши назву проекту, натисніть кнопку "ОК", щоб 

зберегти проект. Це запропонує вам зберегти модель у 

американських одиницях (US units), Рис. 2.5, але згодом її можна 

буде змінити. Тому ви можете натиснути кнопку ОК.  

  
Рис. 2.4. Project Title 
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Рис. 2.5. US units 

3. Визначення розмірності проектних одиниць 

Проект можна змінити в Options (Опції) > Unit System, Рис. 

2.6 

 
  

Рис. 2.6. Define project units system 

 

4. Визначення геометрії 

Для визначення геометрії відкрийте Geometric Data 

(Геометричні дані) з Edit Menu (меню Правка, Рис. 2.7). 

  
Рис. 2.7. Geometric Data 
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Він відобразить вікно "Geometric Data", рис. 7, у якому 

доступні різні інструменти. Якщо ви навести курсор на іконки, 

з’явиться невеликий опис команди  

 
Рис. 2.8. Draw window Geometric Data 

 

Клацніть на Draw River Reach та починайте оцифровувати 

річковий простір від верхньої та нижнього течії. 

Потім двічі клацніть та визначте River (Річка) та Reach Name 

(Назва ділянки річки)  

Reach може мати кілька різних значень залежно від того, як 

воно використовується. Зазвичай Reach - це ділянка струмка або 

річки, уздовж якого існують аналогічні гідрологічні умови, такі 

як витрата, глибина, площа і ухил. У практичному використанні 

Reach часто використовується гідрологами, коли вони 

відносяться до невеликого ділянці струмка або річки, а не до всієї 

її довжині. 
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Рис. 2.9. New Geometric Data 

 

В головному вікні програми з’явиться назва і шлях де 

зберігається створена геометрія потоку (рис. 10). 

 

 
Рис. 2.10. Головне вікно програми з назвою і шляхом до  

Geometric Data 
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Рис. 2.11. Geometric Data, створення назви ділянки 

 

У цьому прикладі ми розробимо систему однієї річки з 

мостом та іншими гідрологічнми особливостями, як показано на 

рис. 11. Ця модель не буде геореференційною, тому ми спочатку 

не будемо вносити жодні геореференційні фонові карти. 

Намалюйте схему річкової системи, виконавши наступні кроки: 

1. Клацніть кнопку River Reach button Річка охоплення у 

вікні геометричних даних (geometric data window). 

2. Перемістіть вказівник миші на область малювання та 

поставте вказівник у тому місці, в якому ви хочете почати 

малювати першу ділянку річки (first reach). 

3. Натисніть ліву кнопку миші один раз, щоб почати 

малювати ділянку (reach). Перемістіть вказівник миші та 

продовжуйте натискати ліву кнопку миші, щоб додати додаткові 

точки до відрізка ділянки (segment). Щоб закінчити малюнок 

ділянки, двічі клацніть лівою кнопкою миші, і остання точка 

ділянки буде розміщена в поточному місці вказівника миші. Усі 

протоки повинні бути проведені від верхньої до нижнього 

частини річки за течією (у позитивному напрямку потоку), 

оскільки програма передбачає, що це правда. 
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Побудова моделі каналу або річки в HEC-RAS є побудова 

його геометричного зображення (як ламана лінія, що складається 

з прямих ділянок і перпендикулярних їм створів - в спрощеному 

вигляді саме русло каналу). Для більш серйозних досліджень і 

вирішення більш складних гідрологічних моделей, 

рекомендується викреслювати канали або річки короткими 

відрізками, що повторюють всі найдрібніші вигини потоку, 

поступово відтворюючи точні його обриси. Однак для вирішення 

поставленого в даній роботі завдання точного зображення форми 

річки не потрібно. В даному випадку річка була представлена 

прямою лінією (див. рис. 11). Єдиною обов'язковою для побудови 

моделі водотоку в програмі HEC-RAS характеристикою є 

довжина. 

Довжина ділянки ріки чи каналу визначається згідно 

завданню на роботу. 

4. Після того, як буде накреслено ділянку, інтерфейс 

програми запропонує ввести ідентифікатор для назви річки 

(River) та назви ділянки (Reach). Ідентифікатор річки (River) 

може містити до 32 символів, тоді як назва ділянки (Reach) 

обмежена 12 символами. У цьому прикладі є одна річка під 

назвою Raba River. Річка містить два гідравлічні показника течії 

– Верхній (Upper Reach) та Нижній (Lower Reach). Raba було 

введено як єдиний гідравлічний об’єкт, а назва ділянки – «12-23», 

згідно номерів поперечних перерізів згідно завданню. 

5. Повторіть кроки від з першого по четвертий для кожної 

ділянки, які будуть розраховуватись. Після введення 

ідентифікаторів для ділянки річки, Вам також буде 

запропоновано ввести ідентифікатор для з'єднання (Junctions). 

Junctions в HEC-RAS - це місця, де дві або більше ділянок річок, 

приток та ін. з'єднуються або розбиваються (join together or split 

apart, User Manual) 

Після того як ви закінчили відображення річкової системи, 

є кілька варіантів їх редагування – змінити ім'я, перемістити 

об’єкт (об'єктами є мітки (labels), місця з'єднання (junctions) та 

точки в межах ділянки (points in the reaches)), додати точки до 

ділянки, видалити точки, видалити ділянки та видалити 
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з'єднання. Функції редагування розміщені в меню Edit у вікні 

Геометричні дані (Geometric Data).  

Представлена вище модель є лише двовимірною (1D). Для 

побудови тривимірної моделі річки необхідно наступним кроком 

побудувати кожен створ окремо. Отже наступним кроком є 

введення даних перерізів. Це досягається натисканням кнопки  

Cross Section (Поперечний переріз) у вікні (Geometric Data) 

Геометричні дані (рис. 7). Після натискання цієї кнопки з'явиться 

редактор даних перетину, як показано на рис. 13 (за винятком 

того, що у вас має бути порожнє). Для введення даних перерізу 

виконайте наступне: 

1. Виберіть River та Reach, з якими будемо працювати. Для 

нашого прикладу це Raba, Reach – 1. 

2. Перейдіть у меню Options «Параметри» та виберіть Add 

a new Cross Section (Додати новий перетин). 

З'явиться вікно введення, щоб запропонувати ввести 

ідентифікатор (рис. 12) нового перетину. Ідентифікатор не 

повинен бути фактичною river station, він повинен бути числовим 

значенням. Числове значення описує, де знаходиться цей 

поперечний переріз відносно інших перерізів в межах ділянки. 

Перерізи розташовані від верхньої, upstream, течії (найвища 

highest river station) до нижньої, downstream, течії (найнижча 

lowest river station). Назви перетинів наведені в завданні. 

 
 

Рис. 2. 12. Ідентифікатор перетинупри створенні нової 

Cross Section  
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Рис. 2. 13. Діалогове вікно Cross Section  

 

Крок 4 (b): Визначте поперечний переріз (Cross Section) 

 

Клікаємо по Cross Section, і він відобразить діалогове вікно 

даних перерізу ( 

 

Рис. 2. 13). 

Тепер у діалоговому вікні, що відображається, натисніть Options 

> Add a new Cross Section (Додати новий перетин). Визначте 

ідентифікатор перетину ( 

Рис. 2. 12) та натисніть кнопку ОК. 

 
Рис. 2. 14. Add a new Cross Section  

 

Перший поперечний переріз буде найнижчим за течією 

перетином. Найнижчий поперечний перетин буде мати останній 

Section ID. Переріз, що знаходиться найвище в даній частині 

потоку, буде мати найвищий Section ID (ідентифікатор розділу). 

1 2 3 4 5 
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Геометрія задається через Cross Section Coordinates – 

координати характеристичних точок (m) поперечного профілю 

(Рис. 2. 13, поз.1); 

Downstream Reach Lengths – відстань до відповідних 

характеристичних точок [left overbank (LOB), main channel 

(Channel), right overbank (ROB)] нижче за потоком 

розташованого поперечного перерізу, довжина ділянки (Рис. 2. 

13, поз.2). 

Manning's Roughness (Коефіцієнт Шорсткості Меннінга) 

в межах  LOB, Channel, ROB, (Рис. 2. 13, поз. 3). 

Для уточнення вводяться координати бровок каналу 

Bank Stations (точки переходу від основного русла до заплави – 

лінія берега), (Рис. 2. 13, поз. 4). 

Для самого найнижчого поперечного перерізу довжина 

досяжності (DownStream Reach Length) буде "0". 

Після введення даних геометрії потоку обов’язково 

натисніть Apply Data (Застосувати дані), щоб побачити геометрію 

перерізу. 

Тепер, щоб визначити наступний поперечний переріз, 

знову натискаємо Options > Add a new Cross Section (Рис. 2. 14). 

Знову визначаємо геометрію, довжину досяжності, 

коефіцієнти шорсткості Меннінга та Bank Stations  для нового 

перерізу. Створити новий поперечний переріз можна 

скопіювавши поточний переріз (Options > Copy Current Cross 

Section) або скористатися командою <Interpolate Cross Section> - 

у вікні (Geometric Data) > Tools > XS Interpolation > Between 2 

XS`s (Рис. 2.15). 

 

 
Рис. 2.15. XS Interpolation Cross Section вибір 

 

Необхідно: 



28 

 

 

 вибрати спосіб копіювання (Maximum Distance (m) - 

максимальна відстань між перерізами, або ж  Constant 

Distance (m) – стала відстань)  

 та натиснути <Interpolate New XS’s> і далі закрити вікно 

<Close> 

 У вікні <Geometry Data> натисніть на <File >, <Save 

Geometry data> (Зберегти дані геометрії) та визначте 

TITLE (НАЗВУ). Програмне забезпечення створить для 

нього файл .g01 

Для копіювання поточного перерізу: 

1. Перейдіть до меню <Options> в Cross Section Data Editor 

та виберіть «Copy Current Cross Section». З'явиться вікно 

введення, яке запропонує вам вибрати річку та місцеположення, 

а потім ввести River Station для нового перерізу.  

 

 
Рис. 2.16. XS Interpolation Options  

2 

1 

4 

5 

3 
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2. Змініть опис поперечного перерізу. 

3. Відрегулюйте всі висоти перерізу шляхом вибору 

функції <Adjust Elevations> в меню <Options> в <Cross Section 

Data Editor>. 

4. Відрегулюйте розміщення overbanks. Це досягається 

шляхом вибору функції <Adjust Stations > у меню <Options> в 

<Cross Section Data Editor>, а потім вибору < Multiply by a Factor>. 

Коли з'явиться вікно введення для цієї опції, будуть доступні три 

поля для введення даних для регулювання розміщення лівого 

overbanks, каналу та правого overbanks окремо.  

 
Рис. 2.17. Adjust Stations, Multiply by a Factor 

 

Stream Junctions - злиття потоків 

При наявності вказуються злиття двох або більше потоків 

разом або розходження потоків на частини. Дані про Junctions 

(з'єднання) складаються з назви Junction Name, опису Description, 

довжини прилеглої ділянки Legth across Junction, поперечний 

переріз стику; кути впадання чи розгалуження; і вибирається 

необхідна розрахункова модель злиття потоків Steady Flow 

Computation Mode, Рис. 2.18. 
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Рис. 2.18. Junction Data 

 

Bridges and Culverts (Мости та прогони) 

Після введення всіх необхідних даних поперечного 

перерізу проектант може потім додати будь-які необхідні Bridges 

(мости) або Culverts (водопропускні споруди під дорогами, 

залізницями ін (18)). HEC-RAS обчислює втрати енергії, 

спричинені такими конструкціями, як мости та водотоки. Одна 

частина складається з втрат, які виникають при надходженні 

потоку безпосередньо до структури, а також на виході, де 

відбувається розширення потоку. Друга частина - це втрати в 

самій структурі, які можна змоделювати декількома різними 

методами. Третя частина складається з втрат, які виникають у 

межах ділянки безпосередньо вище за течією конструкції, де 

потік стискається, щоб пройти через отвір, Рис. 2.19. 
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Рис. 2.19. Принципи обрахунку Bridges and Culverts  

 

Inline Structures (Dams, Weirs and Gated Spillways)  

Введення та редагування даних вбудованої структури 

(Inline Structure Data). Дані Inline Structure Data (вбудованої 

структури) вводяться аналогічно, як дані мостів та прогонів.  

Для введення вбудованої структури натисніть кнопку Inline 

Structure button у вікні Geometric Data. Після натискання цієї 

кнопки з'явиться редактор даних вбудованих структур (Structure 

Data editor), як показано на Рис. 2.20 (крім ваших буде порожньо, 

поки ви не введете деякі дані). 
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Рис. 2.20. Inline Structures Data  

 

 

5. Визначення даних усталеного потоку 

 

У вікні < Defining Steady Flow Data> (Визначення даних про 

постійний потік) визначте кількість профілів, розрядів та 

граничні умови 



33 

 

 

 
Рис. 2. 21. Steady Flow Data  
 

Також можна змінити назву профілю. За замовчуванням це 

PF1 та PF2, але можна перейти до Option > Edit Profiles Names 

(див. рис. нижче). Всього програма дозволяє створити до 32000 

профілів (враховуйте можливості Вашого hardware).  

 
 

Рис. 2. 22. Edit Profiles Names 
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У наведеному прикладі я буду прописувати режим 

субкритичного потоку (Subcritical Flow  Regime), тому, після 

того, як всі дані про потік будуть введені, наступним кроком буде 

введення граничних умов, зокрема для нашого прикладу 

Downstream Boundary Conditions через редактор граничних умов 

Steady Flow Boundary Conditions, яке викликається кнопкою 

Reach Boundary Conditions ... (див. рис. нижче). 

 
Рис. 2. 23. Steady Flow Boundary Conditions 

 

Граничні умови необхідні для встановлення вихідної 

водної поверхні (starting water surface) на кінцях річкової системи 

(вгору і вниз за течією). Для того, щоб програма почала 

розрахунки, необхідна стартова водна поверхня (starting water 

surface). У до- (суб)критичному режимі течії граничні умови 

необхідні тільки на нижніх кінцях річкової системи. Якщо буде 

розрахований supercritical режим потоку, граничні умови 

необхідні тільки на верхніх кінцях річкової системи. Якщо 

передбачається провести розрахунок режиму змішаного перебігу 

(mixed flow regime), то граничні умови повинні бути введені на 

всіх кінцях річкової системи. 

Редактор граничних умов містить таблицю зі списком усіх 

ділянок (reach). У кожної ділянки є граничні умови upstream та 

downstream. Приєднання до з'єднання (junctions) вважаються 

внутрішніми граничними умовами. Внутрішні граничні умови 

автоматично перераховані в таблиці в залежності від того, як 

річкова система була визначена в редакторі геометричних даних. 

Від користувача потрібно тільки ввести необхідні зовнішні 

граничні умови. 

2 1 
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Щоб ввести граничну умову, спочатку мишкою виберіть 

положення осередку (cell location), в якій ви хочете ввести 

граничну умову. Потім виберіть тип граничної умови з чотирьох 

доступних типів, перерахованих над таблицею: 

Known Water Surface Elevations (Відомі позначки водної 

поверхні) – для цієї граничної умови користувач повинен ввести 

відому водну поверхню для кожного з профілів, які будуть 

обчислені. 

Critical Depth (Критична глибина) – користувачеві не 

потрібно вводити будь-яку додаткову інформацію. Програма 

розрахує критичну глибину для кожного з профілів і буде 

використовувати її в якості граничної умови. 

Normal Depth (Нормальна глибина) – користувач повинен 

ввести нахил енергії (energy slope), який буде використовуватися 

при обчисленні нормальної глибини (рівняння Маннинга – 

Manning's equation) в цьому місці. Нормальна глибина буде 

розрахована для кожного профілю на основі введеного 

користувачем у вікні Cross Section нахилу. Якщо нахил енергії 

невідомий, користувач може апроксимувати його, ввівши або 

нахил поверхні води, або нахил дна каналу. 

Rating Curve  (Крива оцінки) – спливаюче вікно дозволяє 

користувачеві ввести криву залежності висоти від швидкості 

потоку (elevation versus flow rating curve). Для кожного профілю 

відмітка інтерполюється з розрахункової кривої з урахуванням 

витрат. 

Додаткова функція редактора граничних умов полягає в 

тому, що користувач може вказати різні типи граничних умов для 

кожного профілю в одному і тому ж місці. Для цього спочатку 

виберіть параметр «Set boundary for one profile at a time» у 

верхній частині вікна (див. рис. вище, поз.2). Якщо вибрати цю 

опцію, таблиця буде розширюватися, щоб надати рядок для 

кожного профілю в кожному місці. Потім користувач може 

вибрати місце розташування і профіль, для якого він хотів би 

змінити тип граничного умови, [20, с. 4–4]. 

Після визначення граничних умов збережіть файл. Це 

створить файл .f01 для даних потоку 
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Відкрийте вікно Flow Analysis (Аналіз потоку)  та 

визначте режим потоку 

 

У вікні Аналіз постійного потоку Steady Flow Analysis  

перейдіть до File > Save Plan (Файл> Зберегти план). Визначте 

TITLE (назва) та короткий ідентифікатор плану та збережіть 

його. Це створить файл .p01 для файлу Plan (в нашому прикладі 

ND2). 

7. Аналіз усталеного потоку 

Перейдіть до вікна Steady Flow Analysis (Аналіз 

усталеного потоку) та натисніть кнопку <Compute> для запуску 

моделювання. 

 
Рис. 2. 24. Steady Flow Boundary Analysis Compute 

 

8. Результати 

Після закінчення аналізу можна переглянути результати, 

отримані в результаті аналізу HEC-RAS. Завжди пам’ятайте, щоб 

переглянути Звіт про помилки, застереження та примітки. 
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Рис. 2. 25. HEC-RAS Finished Computations 

 

8.2. Експорт моделі каналу 1Д з Autodesk Civil 3D в програму 

HEC-RAS 

Для створення моделі каналу 1Д в програмі HEC-RAS 

використаємо вже створену модель рельєфу та накреслений на 

цьому рельєфі канал 1Д, зроблені в Autodesk Civil 3D. Команда 

«Export To HEC-RAS», дозволяє експортувати інформацію про 

поверхні, геометрію самої траси, перерізи для використання в 

програмі HEC-RAS. 

1-й етап – підготовка креслення Autodesk Civil 3D до 

експорту 

• У Autodesk Civil 3D відкриваємо креслення, що містить 

модель нашого каналу 1Д, який ми хочемо дослідити, разом з 

існуючою поверхнею землі. 
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• Визначаємо вісь потоку як трасу. Увага! Маємо 

переконатись, що запропонована позиція йде в бажаному 

напрямку (показується стрілкою). 

• Створюємо групу ліній поперечних перерізів за станціями 

в бажаних положеннях уздовж осі каналу (наші майбутні 

Overbanks). Увага! Для проведення аналізу каналу в HEC-RAS 

маємо переконатися, що лінії каналу не виходять за межі 

поверхні. 

• Створюємо траси або полілінії для визначення лівого і / 

або правого берега каналу. Примітка. Розташування Overbanks 

відображається в додатку HEC-RAS у вигляді червоних крапок 

на секціях. Розташування лівого і правого берега повідомляє 

HEC-RAS, де значення коефіцієнтів n Меннінга змінюються 

(каналу, лівого та правого Overbanks). Це впливає на розрахунки 

і рівень води в секції. 

• BestPractice: рекомендується використовувати те ж 

креслення для експорту даних, яке буде використовуватися в 

HEC-RAS. 

 
Рис. 2.26. Модель каналу в Autodesk Civil 3D  
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2-й етап – процедура експорту. Клікаємо вкладку «Вывод» 

панель «Експорт» «Експорт в HEC RAS». 

 

 
Рис. 2.27. Вибір меню експорту «Export To HEC-RAS» 

 

У діалоговому вікні «Експорт в HEC RAS» для параметра 

«Поверхня» (Surface) вибираємо поверхню, яку будемо 

використовувати у моделюванні. 

 

 
Рис. 2.28. Меню параметрів експорту 

 

Для Site, вибираємо Site, на якому розміщено наш канал (в 

нашому випадку ми сформували Site Канали). Якщо наш канал 

не знаходився б на жодному сайті вибрали б <Ні>. 

В поле Reach Alignment вибираємо вирівнювання, що 

містить осьову лінію потоку (stream centerline). 
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При необхідності вибираємо групу ліній (Sample Line 

Group), що містить секції, які ми експортуємо (в нас відсутні такі 

групи). 

Вводимо назву річки (Рис. 2.28, поз. 1). Зазвичай це так і є 

ім'я потоку (каналу, річки, струмка). Це ім'я використовується в 

додатку HEC-RAS як заголовок файлу GEO і використовується 

як мітка для потоку в вікні геометричних даних HEC-RAS (HEC-

RAS Geometric Data). 

Щоб експортувати інформацію про береги річки (river 

bank), вибираємо «Відзначити для використання берегів річки» 

(Check This To Use River Banks), тиснемо «Лівий та / або 

«Правий» і вибираємо полілінії (або траси – як ми їх накреслили) 

на кресленні (Рис. 2.28, поз. 2). 

Примітка. Розташування банків (bank) відображається в 

додатку HEC-RAS у вигляді червоних крапок в секціях (sections). 

Розташування лівого і правого берега повідомляє HEC-RAS, де 

значення коефіцієнта n Меннінга змінюються для ситуацій 

основного потоку, лівого та правого берегів в секції. Це впливає 

на розрахунки і рівень води в секції. Позиції банків, що 

експортуються в файл GEO, вимірюються у відсотках від 

загальної довжини секції, а не як відносні відстані зміщення. 

Вибираємо «Експорт». 

У діалоговому вікні «Експорт даних в файл GEO» 

переходимо до місця, де ми хочемо зберегти файл GEO. 

Вводимо ім'я файлу. Клацаємо «Зберегти» (Save). 

Натискаємо OK, щоб закрити діалогове вікно «Export To 

HEC RAS». 

Переходимо в програму HEC RAS 

Крок 1. Відкриваємо HEC-RAS 

Крок 2. Визначаємо проектні одиниці Options (Опції) > Unit 

System  
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Крок 3. Створюємо новий проект  

Крок 4. Відкриваємо експортований з Autodesk Civil 3D 

файл геометрії  

“назва_файлу.g01” наступним чином: Edit -> Geometric 

Data (Визначення геометрії) -> 

-> File -> Import Geometric Data -> GIS Format. і шукаємо в 

папках файл геометрії “назва_файлу.g01”. Не забуваємо 

корегувати параметри імпорту геоданих, наприклад вибираємо 

метричні одиниці: Current RAS project units - SI (metric) unit (рис. 

5.1) 
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Рис. 2.29. Меню імпорту геометрії (Import Geometric Data, 

GIS Format)   

 

Не забуваємо перевірити River Reach Stream Line (Рис. 2.29, 

поз. 2) Cross Sections and IB Nodes .  

В зв’язку з тим, що HEC-RAS нумерує поперечні перерізи 

автоматично за напрямком течії нам необхідно скопіювати ці дані 

в Excel і пересорувати. 

Після корегування тиснемо Finished - Import Data. 

Отримаємо пророблену геометрію каналу. 

Крок 5. Імпортуємо межі русла каналу, які автоматично не 

підтягнулись. Для цього заходимо в вкладку Tables і відкриваємо 

Edit Downstream Reach Lenghts де                        проводимо 

відповідні значення LOB та ROB (Рис. 2.30). 
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Рис. 2.30. Визначення геометрії русла в Edit Downstream 

Reach Lenghts 
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